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RL78/G24 
Interleaved CrM PFC and LLC Control Using RL78/G24(CPU Software) 

Introduction 
This application note describes how to control an interleaved CrM PFC and an LLC converter using the 
features of the RL78/G24 microcontroller. 

 

Target Device 
RL78/G24 

 

 

Board 
RL78/G24 Interleaved PFC + LLC Board 400W Kit (RTK0EL0006D00000BJ) 

 

 

Note: When applying the sample application to other microcontrollers, modify it according to the 
specifications of that microcontroller and evaluate it thoroughly. 

 

 

Related Documents 
・Interleaved CrM PFC and LLC Control Using RL78/G24(Hardware & Software Basics) (RA01AN8175) 

・Interleaved CrM PFC and LLC Control Using RL78/G24(FAA Software) (RA01AN8176) 

・RL78/G24 User’s Manual: Hardware (R01UH0961) 

・CS+ Integrated Development Environment User’s Manual: Project Operation (R20UT4691) 

・e² studio Integrated Development Environment User’s Manual: Quick Start Guide (R20UT5293) 

・RL78 Smart Configurator User's Guide: CS+ (R20AN0580) 

・RL78 Smart Configurator User's Guide: IAR (R20AN0581) 

・RL78 Smart Configurator User's Guide: e2 studio (R20AN0579) 
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1. Specification Overview 
In this sample application, the interleaved PFC (Power Factor Correction) converter and the LLC converter 
are controlled using the Timer KB PWM output function of the RL78/G24 microcontroller. The 
constant-voltage control of each converter is implemented through a feedback process based on PI 
(Proportional-Integral) control. As a result, no dedicated external control IC is required, enabling a reduction 
in overall design cost. 

 

This application note, as the CPU Software Edition, mainly covers the following topics: 

・ Operating conditions of the sample program 

・ Software structure and control overview 

・ Usage with each development environment (CS+, e2 studio, and IAR) 

・ Specifications of the provided APIs 

 

For detailed information on the target board, hardware configuration, and the software control overview of the 
sample program, refer to the following document. 

 

Interleaved CrM PFC and LLC Control Using RL78/G24 (Hardware & Basic Software) (R01AN8175) 
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2. Operating Conditions 
The sample program has been tested under the following environment.  
 

Table 2.1 Operating conditions 

Item Description 
Microcontroller used RL78/G24 (R7F101GFGxFP) 
Board used RL78/G24 Interleaved PFC + LLC Board 400W Kit 

(RTK0EL0006D00000BJ) 
  

Operating frequency High-speed On-chip Oscillator Clock (fHOCO): 8 MHz 
PLL Clock (fPLL): 96 MHz 
CPU / Peripheral Hardware Clock (fCLK): 48 MHz 

Operating voltage AC 100V, 230V 
CS+ for CC Integrated Development 

Environment (IDE) 
Renesas Electronics 

CS+ for CC V8.14.00 
Compiler CC-RL V1.15.01 

IAR Integrated Development 
Environment (IDE) 

IAR Systems 

IAR Embedded Workbench for Renesas RL78 V5.10.3 
Compiler IAR C/C++ Compiler for Renesas RL78  

V5.10.3.2716 

e2 studio Integrated Development 
Environment (IDE) 

Renesas Electronics 

e2 studio 2025-10 
Compiler CC-RL V1.15.01 

Smart Configurator (SC) V1.15.0 
[Components Used] 
Board Support Packages V1.91 
A/D Converter V1.8.0 
D/A Converter V1.5.0 
PWM Output V1.10.1 
UART Communication V1.10.0 
Interval Timer V1.8.0 
Comparator V1.5.1 
Port V1.8.0 
High/Low Pulse Width Measurement V1.7.0 
Interrupt Controller V1.7.0 
Watchdog Timer V1.7.0 
Voltage Detector V1.6.1 

 

 

  



RL78/G24 Interleaved CrM PFC and LLC Control Using RL78/G24(CPU Software) 

R01AN8177EJ0100  Rev.1.00  Page 6 of 39 
Mar. 19.26  

3. Hardware Specifications 
For detailed information on the target board and hardware, refer to Chapter 2 of the following document: 

 

Interleaved CrM PFC and LLC Control Using RL78/G24 (Hardware & Basic Software) (R01AN8175) 
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4. Software Specifications 

4.1 Environment Setup 
This sample program provides projects that operate with two compilers: the CC-RL version and the IAR 
version. The environment setup procedures for each compiler are described below. 

 

4.1.1 CC-RL Version (CS+ for CC) 
This section describes the environment setup procedure for the CC-RL version (CS+ for CC). 

 

4.1.1.1 Downloading and Installing CS+ for CC 
To run the sample application, the CS+ for CC integrated development environment is required. 

Please download and install it from the Renesas Electronics website. 

 

4.1.1.2 Launching the Sample Application 
1. Extract the provided project files and place them in any desired folder. 

2. Double-click TvPower_CPU.mtpj in the extracted project folder. 

 

4.1.1.3 Building the Sample Application 
1. From the CS+ for CC menu bar, click [Build] → [Build Project]. 

2. The build process will start, and its progress will be shown in “All Messages”. When the message 
“Build Finished” appears, the build is complete. 

 

4.1.1.4 Debugging the Sample Application 
1. Connect the E2 Lite to the E2 Lite connector on the debug board mounted on the target board. 

2. Open JP400 on the debug board. 

3. Configure the system to supply 3.3V power from the E2 Lite to the debug board. 

4. Apply the AC input voltage between CN1 and CN2 on the target board. 

5. From the CS+ for CC menu bar, click [Debug] → [Download to Debug Tool]. 

6. Download the program to the microcontroller. 

7. Click [Debug] → [Go] to start debugging the sample application. 

 

Note:  
When using breakpoints, for safety reasons, please set 
“Debug Configuration” → “Debug Tool Settings” → “Stop timer group emulation while stopped” to 
“Yes”, so that the timer outputs are stopped (Hi-z) while execution is halted at a breakpoint. 

In addition, if the program stops at a breakpoint, do not resume execution from that point. 
Please reset the CPU and restart the program from the beginning. 
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4.1.2 CC-RL Version (e2 studio) 
This section describes the environment setup procedure for the CC-RL version (e2 studio). 

 

4.1.2.1 Downloading and Installing e2 studio 
To run the sample application, the e2 studio integrated development environment is required. 
Please download and install it from the Renesas Electronics website. 

 

4.1.2.2 Importing the Sample Application 
1. Extract the provided project files and place them in any desired folder. 

2. Launch e2 studio. 

3. From the e2 studio menu bar, select [File] → [Import]. 

4. Select Existing Projects into Workspace, then click Next. 

5. Select “Browse” under Root Directory Selection, then choose the project root directory placed in step 
1. 

6. Check TvPower_CPU in the project list, then click Finish. 

 

4.1.2.3 Building the Sample Application 
1. In the Project Explorer, right-click the imported sample project and select “Build Project”. 

2. The build process will start, and its progress will be shown in the Console view. When the message 
“Build Finished.” appears, the build is complete. 

 

4.1.2.4 Debugging the Sample Application 
1. Connect the E2 Lite to the E2 Lite connector on the debug board mounted on the target board. 

2. Open JP400 on the debug board. 

3. Configure the system to supply 3.3V power from the E2 Lite to the debug board. 

4. Apply the AC input voltage between CN1 and CN2 on the target board. 

5. Click the button in e2 studio. 

6. The program will be downloaded to the microcontroller, and debugging will begin. 

 
Note:  
For safety, when breakpoints are used, enable “A (Timer)” under “Peripheral Break” in the debugger 
“Hardware Settings” to ensure that timer outputs enter the Hi-Z state during break. 

If the program stops at a breakpoint, do not continue execution from that point. Reset the CPU and execute 
the program from the beginning. 
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4.1.3 IAR Version 
This section describes the environment setup procedure for the IAR version. 

 

4.1.3.1 Downloading and Installing IAR Embedded Workbench 
To run the sample application, the IAR Embedded Workbench for Renesas RL78 integrated development 
environment is required. 
Please download and install it from the IAR Systems website. 

 

4.1.3.2 Launching the Sample Application 
1. Launch IAR Embedded Workbench for Renesas RL78. 

2. From the “File” menu, select “New Workspace”. 

3. From the “File” menu, select “Save Workspace As”, and save the workspace with any desired name 
and in any desired folder. 

4. Extract the provided project files and place them in the workspace folder created in step 3. 

5. From the “Project” menu, select “Add Existing Project”, and choose the project file (EWP file) placed in 
step 3. 

6. From the “File” menu, click “Exit”. 

 

4.1.3.3 Building the Sample Application 
1. In the workspace, right-click the project and select “Make”. 

2. The build process will start, and its progress will be shown in the Console window. When the message 
“Total number of errors: 0” appears, the build is complete. 

 

4.1.3.4 Debugging the Sample Application 
1. Connect the E2 Lite to the E2 Lite connector on the debug board mounted on the target board. 

2. Open JP400 on the debug board. 

3. Configure the system to supply 3.3V power from the E2 Lite to the debug board. 

4. Apply the AC input voltage between CN1 and CN2 on the target board. 

5. Click the  button in IAR Embedded Workbench for Renesas RL78. 

6. The program will be downloaded to the microcontroller, and debugging will begin. 

 

Note:  
When using breakpoints, pay close attention to timer operation, and reset the CPU as necessary. 
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4.2 Software Control 
For an overview of the software control implemented in the sample program, refer to Chapter 3 of the 
following document: 

 

Interleaved CrM PFC and LLC Control with RL78/G24 (Hardware & Software Basics) (R01AN8175) 

 

4.3 Software Configuration 
This section describes the software configuration of the sample program. 

 

Figure 4.1 Software Configuration Diagram 
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4.3.1 Folder Structure 
This section describes the folder structure of the sample program. 

 

Table 4.1 Folder Structure 
Folder / File Name Description 

TvPower_CPU Folder containing the sample program 
 main.c Main source file 

QE Config Folder for QE for Lighting & Power 
 r_powerConfig.h Configuration header file for QE for Lighting & Power 
Src Folder containing source code 
 r_common.h Common definitions header file 

application Folder containing application program 
 r_tvpower.c Source file for the TV power application 

r_tvpower.h Header file for the TV power application 
middleware Folder containing middleware programs 
 r_pfc.c Source file for PFC control middleware 

r_pfc.h Header file for PFC control middleware 
r_llc1.c Source file for LLC1 control middleware 
r_llc1.h Header file for LLC1 control middleware 
r_llc2.c Source file for LLC2 control middleware 
r_llc2.h Header file for LLC2 control middleware 

driver Folder containing driver programs 
 r_acv.c Source file for AC voltage detection driver 

r_acv.h Header file for AC voltage detection driver 
r_acz.c Source file for AC zero‑cross detection driver 
r_acz.h Header file for AC zero-cross detection driver 
r_adc.c Source file for A/D converter driver 
r_adc.h Header file for A/D converter driver 
r_clock.c Source file for operating clock configuration driver 
r_clock.h Header file for operating clock configuration driver 
r_debugio.c Source file for debug I/O driver 
r_debugio.h Header file for debug I/O driver 
r_ir.c Source file for IR driver 
r_ir.h Header file for IR driver 
r_port.c Source file for port driver 
r_port.h Header file for port driver 
r_pushsw.c Source file for push‑switch driver 
r_pushsw.h Header file for push-switch driver 
r_submcuio.c Source file for Sub-MCU I/O driver 
r_submcuio.h Header file for Sub-MCU I/O driver 
r_timer.c Source file for timer driver 
r_timer.h Header file for timer driver 

smc_gen Folder generated by Smart Configurator (remaining items omitted) 
* Library code used in this sample is generated under this folder. 
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4.3.2 Option Byte Settings 
Table 4.2 shows the option byte settings. 

 

Table 4.2 Option Byte Settings 
Address Setting Value Description 

000C0H/040C0H 1111 0010 (F2H) Watchdog timer operation permitted 

・ Overflow time: 28/fIL (7.8125 ms) 

・ After reset is released, counting starts 

・ Counter operation stopped in the HALT or STOP mode 

000C1H/040C1H 0011 1010 (3AH) LVD reset mode (falling: 2.91 V, rising: 2.97 V) 

000C2H/040C2H 1110 1010 (EAH) Flash operation mode: High-speed main mode 

High-speed on-chip oscillator frequency: 8 MHz 

000C3H/040C3H 1000 0100 (84H) On-chip debug operation enabled 
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4.3.3 API Functions 
This section describes the API functions used in the application layer and middleware layer of the sample 
program. 

 

4.3.3.1 r_tvpower.c 
This table lists the API functions defined in r_tvpower.c in the application layer. 

 

Table 4.3 Application API Functions 

Function Name Description 

R_TVPOWER_Init Initializes the power-control application operation. 

R_TVPOWER_Task Executes the task processing for the power-control application. 
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4.3.3.2 r_pfc.c 
This table lists the API functions defined in r_pfc.c in the middleware layer. 

 

Table 4.4 PFC Control API Functions 

Function Name Description 

R_PFC_Init Initializes the PFC control function. 

R_PFC_StartBoost Starts the PFC boost‑mode control. 

R_PFC_StartBurst Starts the PFC burst‑mode control. 

R_PFC_StartNormalSingle Starts normal PFC control (single‑output operation). 

R_PFC_SwitchToInterleaved Switches the PFC output to interleaved mode. 

R_PFC_SwitchToSingle Switches the PFC output to single mode. 

R_PFC_Stop Stops the PFC control. 

R_PFC_TickMs Notifies the tick timing for PFC control. 

R_PFC_GetStatus Retrieves the PFC control status. 

R_PFC_Tick50us Executes processing performed every 50 us. 

R_PFC_FeedbackCycleProcess Executes the PFC feedback‑cycle processing. 

R_PFC_GetMaxFreqLimit Retrieves the maximum frequency‑limit setting for PFC control. 

R_PFC_UpdateMaxFreqLimit Updates the maximum frequency‑limit setting for PFC control. 

R_PFC_GetLoadPower100V Estimates and retrieves the load power (AC 100 V). 

R_PFC_GetLoadPower200V Estimates and retrieves the load power (AC 200 V). 

R_PFC_DetectOcpCallback Callback function invoked during an OCP event.  

This function must be called when OCP occurs. 

R_PFC_SetKp Sets the proportional gain (Kp) for the feedback processing. 

R_PFC_SetFz Sets the zero‑point frequency (fz) for the feedback processing. 

R_PFC_GetOnWidthCount Retrieves the on‑width setting value for the PFC master side. 
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4.3.3.3 r_llc1.c 
This table lists the API functions defined in r_llc1.c in the middleware layer. 

 

Table 4.5 LLC1 Control API Functions 

Function Name Description 

R_LLC1_Init Initializes the LLC1 control function. 

R_LLC1_StartBurst Starts the LLC1 burst‑mode control. 

R_LLC1_StartNormal Starts the LLC1 normal‑mode control. 

R_LLC1_Stop Stops the LLC1 control. 

R_LLC1_TickMs Executes processing performed at the tick timing for LLC1 control. 

R_LLC1_GetStatus Retrieves the LLC1 control status. 

R_LLC1_Tick50us Executes processing performed every 50 us for LLC1 control. 

R_LLC1_FeedbackCycleProcess Executes the LLC1 feedback‑cycle processing. 

R_LLC1_DetectOcpCallback Callback function invoked during an OCP event. 

This function must be called when OCP occurs. 

 

 

4.3.3.4 r_llc2.c 
This table lists the API functions defined in r_llc2.c in the middleware layer. 

 

Table 4.6 LLC2 Control API Functions 

Function Name Description 

R_LLC2_Init Initializes the LLC2 control function. 

R_LLC2_StartBurst Starts the LLC2 burst‑mode control. 

R_LLC2_StartNormal Starts the LLC2 normal‑mode control. 

R_LLC2_Stop Stops the LLC2 control. 

R_LLC2_TickMs Executes processing performed at the tick timing for LLC2 control. 

R_LLC2_GetStatus Retrieves the LLC2 control status. 

R_LLC2_Tick50us Executes processing performed every 50 us for LLC2 control. 

R_LLC2_FeedbackCycleProcess Executes the LLC2 feedback‑cycle processing. 

R_LLC2_DetectOcpCallback Callback function invoked during an OCP event. 

This function must be called when OCP occurs. 
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5. Operation Using QE for Lighting & Power 
QE for Lighting & Power (version 2.0.0 or later) enables an integrated workflow that covers power‑control 
parameter configuration, simulation, evaluation, and code generation. 

This chapter describes the sequence of operations for verifying and evaluating the power‑control functions of 
the target board using QE for Lighting & Power. 

 

5.1 Downloading QE for Lighting & Power 
Download and install QE for Lighting & Power from the Renesas Electronics website. 

 

5.2 Prepare a Workspace 
Configure the workspace, which specifies the target board and the folder where the application program will 
be stored. 

 

5.2.1 Select a Board 
1. Open “2.Prepare a Workspace” and select “Renesas Board.” 

2. From Target Project Selection, select: 
[R01AN8175EJ0100] Interleaved CrM PFC and LLC Control with RL78/G24 (Hardware & Software 
Basics). 

 

5.2.2 Select a Workspace 
From “Select a Workspace”, select any folder that will be used to store the application program. 

 

 

Figure 5.1 Prepare a Workspace 
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5.3 Configure Lighting Communication 
The target project does not support lighting communication; therefore, “3.Configure Lighting Communication” 
cannot be used. 

 

 

Figure 5.2 Configure Lighting Communication 
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5.4 Configure Power Control 
In “4. Configure Power Control” you can modify circuit characteristics and power‑control parameters using 
the Power Configuration view 

 

 

Figure 5.3 Configure Power Control 
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5.4.1 Configure Power Control Mode 
Enabling “Configure Power Control Mode” allows you to use the power‑control functions, including parameter 
configuration, simulation, and code generation. 

 

5.4.1.1 Power Configuration View 
By clicking the “Open Power Configuration View” button, you can view the circuit diagram and modify circuit 
characteristics and power‑control parameters. The Power Configuration View consists of the target board’s 
circuit diagram (upper area) and the configurable parameters (lower area). 

 

 

Figure 5.4 Power Configuration (Circuit Diagram of the Target Board) 
 

 

Figure 5.5 Power Configuration (Configurable Parameters) 
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The configurable parameters consist of “Circuit Characteristics” and “Power Control Parameters.” 

The Circuit Characteristics section allows you to configure the circuit‑related parameters. The parameters set 
here are reflected in the power‑control simulator described later. 

 

Table 5.1 Circuit Characteristics (1/3) 

Item Default Value Description 

Common AC freq (Hz) 60 Frequency of the AC input voltage. 

Synchronous Rectification Unchecked Switches between synchronous and 
asynchronous rectification for the LLC 
stage. When checked, synchronous 
rectification is enabled. 

PFC_M Power MOSFET Ron (Ω) 0.281 MOSFET Ron of the PFC master side [Ω] 

Ids (A) 6.3 MOSFET Ids of the PFC master side [A] 

Vth (V) 3.5 MOSFET Vth of the PFC master side [V] 

Vgs (V) 10 MOSFET Vgs of the PFC master side [V] 

Ciss (pF) 1317 MOSFET Ciss of the PFC master side [pF] 

Coss (pF) 520 MOSFET Coss of the PFC master side [pF] 

Crss (pF) 80 MOSFET Crss of the PFC master side [pF] 

Inductor L1 (µH) 180 Primary‑side inductance L1 of the PFC 
master transformer [µH] 

Inductor L2 (µH) 18 Secondary‑side inductance L2 of the PFC 
master transformer [µH] 

PFC_S Power MOSFET Ron (Ω) 0.5 MOSFET Ron of the PFC slave side [Ω] 

Ids (A) 6.3 MOSFET Ids of the PFC slave side [A] 

Vth (V) 3.5 MOSFET Vth of the PFC slave side [V] 

Vgs (V) 1317 MOSFET Vgs of the PFC slave side [V] 

Ciss (pF) 520 MOSFET Ciss of the PFC slave side [pF] 

Coss (pF) 520 MOSFET Coss of the PFC slave side [pF] 

Crss (pF) 80 MOSFET Crss of the PFC slave side [pF] 

Inductor L1 (µH) 180 Primary‑side inductance L1 of the PFC 
slave transformer [µH] 

Inductor L2 (µH) 18 Secondary‑side inductance L2 of the PFC 
slave transformer [µH] 
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Table 5.2 Circuit Characteristics (2/3) 

Item Default Value Description 

LLC1 Power MOSFET 
High Side 

Ron (Ω) 0.237 LLC1 high side MOSFET Ron [Ω] 

Ids (A) 3.6 LLC1 high side MOSFET Ids [A] 

Vth (V) 4 LLC1 high side MOSFET Vth [V] 

Vgs (V) 10 LLC1 high side MOSFET Vgs [V] 

Ciss (pF) 807 LLC1 high side MOSFET Ciss [pF] 

Coss (pF) 249 LLC1 high side MOSFET Coss [pF] 

Crss (pF) 80 LLC1 high side MOSFET Crss [pF] 

Power MOSFET 
Low Side 

Ron (Ω) 0.237 LLC1 low side MOSFET Ron [Ω] 

Ids (A) 3.6 LLC1 low side MOSFET Ids [A] 

Vth (V) 4 LLC1 low side MOSFET Vth [V] 

Vgs (V) 10 LLC1 low side MOSFET Vgs [V] 

Ciss (pF) 807 LLC1 low side MOSFET Ciss [pF] 

Coss (pF) 249 LLC1 low side MOSFET Coss [pF] 

Crss (pF) 80 LLC1 low side MOSFET Crss [pF] 

Inductor L1 (µH) 525 Primary-side inductance L1 of the LLC1 
transformer [µH] 

Inductor L2 (µH) 2.5 Secondary‑side inductance L2 of the LLC1 
transformer [µH] 

Inductor L3 (µH) 2.5 LLC1 L3 [µH] 

Inductor LR (µH) 75 Load inductance LR of LLC1 [µH] 

Capacitor CR (µF) 0.044 Resonant capacitor CR of LLC1 [µF] 

 



RL78/G24 Interleaved CrM PFC and LLC Control Using RL78/G24(CPU Software) 

R01AN8177EJ0100  Rev.1.00  Page 22 of 39 
Mar. 19.26  

 

Table 5.3 Circuit Characteristics (3/3) 

Item Default Value Description 

LLC2 Power MOSFET 
High Side 

Ron (Ω) 0.237 LLC2 high side MOSFET Ron [Ω] 

Ids (A) 3.6 LLC2 high side MOSFET Ids [A] 

Vth (V) 4 LLC2 high side MOSFET Vth [V] 

Vgs (V) 10 LLC2 high side MOSFET Vgs [V] 

Ciss (pF) 807 LLC2 high side MOSFET Ciss [pF] 

Coss (pF) 249 LLC2 high side MOSFET Coss [pF] 

Crss (pF) 80 LLC2 high side MOSFET Crss [pF] 

Power MOSFET 
Low Side 

Ron (Ω) 0.237 LLC2 low side MOSFET Ron [Ω] 

Ids (A) 3.6 LLC2 low side MOSFET Ids [A] 

Vth (V) 4 LLC2 low side MOSFET Vth [V] 

Vgs (V) 10 LLC2 low side MOSFET Vgs [V] 

Ciss (pF) 807 LLC2 low side MOSFET Ciss [pF] 

Coss (pF) 249 LLC2 low side MOSFET Coss [pF] 

Crss (pF) 80 LLC2 low side MOSFET Crss [pF] 

Inductor L1 (µH) 425 Primary‑side inductance L1 of the LLC2 
transformer [µH] 

Inductor L2 (µH) 28 Secondary‑side inductance L2 of the LLC2 
transformer [µH] 

Inductor L3 (µH) 28 LLC2 L3 [µH] 

Inductor LR (µH) 75 LLC2 inductor L3 [µH] 

Capacitor CR (µF) 0.044 Resonant capacitor CR of LLC2 [µF] 
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Power Control Parameters is used to configure parameters related to power control. The parameters 
configured here are reflected in both the power-control simulator described later and the generated program. 
This document lists the parameter settings used in the CPU-based evaluation program. 

 

Table 5.4 Power Control Parameter List (1/3) 

Item Default Value Description 

PFC DAC value for PFC OCP 
detection 

122 DAC value used for PFC OCP detection. 

Example (VDD = 5 V, peak current = 10 A): 

DAC output voltage [V] = 10 A × 0.2 Ω × 1.2 (20% 
margin) = 2.4 V 

PFC_CS_LIMIT_FOR_DAC = (2.4 V / 5 V) × 256 = 
122 

PFC output voltage target 2735 Target A/D value for the PFC_V_FB pin. 

Based on measured values, the following 
provisional formula is used: 

PFC_ADC_TARGET = 6.528 × Voltage + 215.428 

Example: Voltage = 386 V 

PFC_ADC_TARGET = 6.528 × 386 + 215.428 = 
2735 

PFC OVP detection 
threshold 

3022 PFC OVP detection threshold 

(Target pin: PFC_V_FB) 

Based on measured values, the following 
provisional formula is used: 

PFC_ADC_OVP_THRESHOLD = 6.528 × Voltage 
+ 215.428 

Example: Voltage = 430 V 

PFC_ADC_OVP_THRESHOLD = 6.528 × 430 + 
215.428 = 3022 

PFC Dynamic-OVP 
detection threshold 

2826 PFC Dynamic‑OVP detection threshold 

(Target pin: PFC_V_FB) 

Based on measured values, the following 
provisional formula is used: 

PFC_ADC_DOVP_THRESHOLD = 6.528 × Voltage 
+ 215.428 

Example: Voltage = 400 V 

PFC_ADC_DOVP_THRESHOLD = 6.528 × 400 + 
215.428 = 2826 
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Table 5.5 Power Control Parameter List (2/3) 

Item Default Value Description 

PFC PFC feedback parameter 
A1 (only for simulation) 

16425 PI control coefficient A1  

A1 = (π × fz × T + 1) × Kp 

To simplify calculation and improve fractional 
precision, A1 must be multiplied by 65536. 

Example: fz = 2 Hz, T = 400 µs, Kp = 0.25 

PFC_PI_PARAM_A1 = (π × 2 × 400 × 10⁻⁶ + 1) × 
0.25 × 65536 = 16425 

PFC feedback parameter 
A2 (only for simulation) 

-16343 PI control coefficient 

A2 = (π × fz × T − 1) × Kp 

To simplify calculation and improve fractional 
precision, A2 must be multiplied by 65536. 

Example: fz = 2 Hz, T = 400 µs, Kp = 0.25 

PFC_PI_PARAM_A2 = (π × 2 × 400 × 10⁻⁶ − 1) × 
0.25 × 65536 = −16343 

LLC1 DAC value for LLC1 OCP 
detection 

860 DAC value used for LLC1 OCP detection. 

Example (VDD = 5 V): 

DAC output voltage [V] = 3.5 V (peak voltage at 
rated load) × 1.20 (margin) = 4.2 V 

LLC1_CS_LIMIT_FOR_DAC = (4.2 V / 5 V) × 1024 
= 860 

LLC1 output voltage 
target 

8 During the LLC1 feedback period (200 µs), the A/D 
value is sampled 16 times, and the sum of the 16 
evaluation results becomes LLC1_ADC_TARGET. 

The valid range of LLC1_ADC_TARGET is 0–16. 

When the LLC1 output voltage is 13 V, 
LLC1_ADC_TARGET becomes 8. 

If the output voltage exceeds 13 V, 
LLC1_ADC_TARGET increases; if the output 
voltage decreases, LLC1_ADC_TARGET 
decreases. 

LLC1 feedback parameter 
A1 

1989 PI control coefficient A1. 

A1 = (π × fz × T + 1) × Kp 

To simplify calculation and improve fractional 
precision, A1 must be multiplied by 65536. 

Example: fz = 1500 Hz, T = 200 µs, Kp = 0.015625 

LLC1_PI_PARAM_A1 = (π × 1500 × 200 × 10⁻⁶ + 
1) × 0.015625 × 65536 = 1989 
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Table 5.6 Power Control Parameter List (3/3) 

Macro Name Default Value Description 

LLC1 LLC1 feedback parameter 
A2 

-59 PI control coefficient A2. 

A2 = (π × fz × T − 1) × Kp 

To simplify calculation and improve fractional 
precision, A2 must be multiplied by 65536. 

Example: fz = 1500 Hz, T = 200 µs, Kp = 0.015625 

LLC1_PI_PARAM_A2 = (π × 1500 × 200 × 10⁻⁶ - 1) 
× 0.015625 × 65536 = -59 

LLC2 DAC value for LLC2 OCP 
detection 

184 DAC value used for LLC2 OCP detection. 

Example (VDD = 5 V): 

DAC output voltage [V] = 3.0 V (peak voltage at 
rated load) × 1.20 (margin) = 3.6 V 

LLC2_CS_LIMIT_FOR_DAC = (3.6 V / 5 V) × 256 = 
184 

LLC2 output voltage 
target 

8 During the LLC2 feedback period (200 µs), the A/D 
value is sampled 16 times, and the sum of the 16 
evaluation results becomes LLC2_ADC_TARGET. 

The valid range of LLC2_ADC_TARGET is 0–16. 

When the LLC2 output voltage is 50 V, 
LLC2_ADC_TARGET becomes 8. 

If the output voltage exceeds 50 V, 
LLC2_ADC_TARGET increases; if the output 
voltage decreases, LLC2_ADC_TARGET 
decreases. 

LLC2 feedback parameter 
A1 

6947 PI control coefficient A1. 

A1 = (π × fz × T + 1) × Kp 

To simplify calculation and improve fractional 
precision, A1 must be multiplied by 65536. 

Example: fz = 1250 Hz, T = 200 µs, Kp = 0.059375 

LLC2_PI_PARAM_A1 = (π × 1250 × 200 × 10⁻⁶ + 
1) × 0.059375 × 65536 = 6947 

LLC2 feedback parameter 
A2 

-835 PI control coefficient A2. 

A2 = (π × fz × T − 1) × Kp 

To simplify calculation and improve fractional 
precision, A2 must be multiplied by 65536. 

Example: fz = 1250 Hz, T = 200 µs, Kp = 0.059375 

LLC2_PI_PARAM_A2 = (π × 1250 × 200 × 10⁻⁶ − 
1) × 0.059375 × 65536 = −835 
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5.4.2 Power Control Simulator 
The Power Control Simulator simulates the behavior of the target board in software using the parameters 
configured in the Power Configuration view. 

By using this simulator, you can check the time‑domain behavior of voltages, currents, and control responses 
for the PFC and LLC stages—such as their trends and characteristics—before verifying them on actual 
hardware. 
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5.4.2.1 Power Control Simulator Dialog 
You can launch the Power Control Simulator by clicking the “Open Power Control Simulation Dialog” button. 
In the simulator, configure the parameters listed below and then click “Start Simulation” to begin the 
simulation. During the simulation, the transitions of each parameter value are visualized as graphs. 

 

Table 5.7 List of Configurable Parameters 

Item Time [ms] 
(Default) 

Default Value Description 

AC Voltage Gain 0.000 282.000 [V] Input voltage. 

The configured value is applied after the 
specified time [ms] has elapsed. 

LLC1 Load 
Resistance 

0.000 100 [Ω] LLC1 load resistance. 

The configured value is applied after the 
specified time [ms] has elapsed. 

LLC2 Load 
Resistance 

0.000 100 [Ω] LLC2 load resistance. 

The configured value is applied after the 
specified time [ms] has elapsed. 

Operating modes 0.000 SW1 SW2 Operation Mode Switch 

Basic Operation: 
After the set time [ms] elapses, the 
configured switch state takes effect. 

• Checked: Switch pressed 

• Unchecked: Switch not pressed 

The switch press duration determines 
short press/long press. 

Determination Conditions: 
Short press: 1999 ms or less 

Long press: 2000 ms or more 

Operation: 
SW1 Short Press: LLC2 Start/Stop 

SW1 Long Press: Maximum Frequency 
Limit Function ON/OFF 

SW2 Short Press: Standby/Normal Mode 
Switch 

SW2 Long Press: Standby/Normal Mode 
Switch 

unchecked unchecked 

Simulation time 
[ms] 

- 5 Simulation duration. 
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Table 5.8 Output Waveform List 

Item Description 

Common Input AC Power AC power [W] 

PFC PFC Output Current PFC output current [A] 

PFC Output Voltage PFC output voltage [V] 

PFC M PWM On Duty PFC master‑side PWM duty ratio [%] 

PFC S PWM On Duty PFC slave‑side PWM duty ratio [%] 

PFC PWM Frequency PFC PWM operating frequency [Hz] 

LLC1 LLC1 Output Current LLC1 output current [A] 

LLC1 Output Voltage LLC1 output voltage [V] 

LLC1 LC Resonant Current LLC1 LC resonant current [A] 

LLC1 Secondary Current LLC1 secondary‑side current [A] 

LLC1 PWM Frequency LLC1 PWM operating frequency [Hz] 

LLC2 LLC2 Output Current LLC2 output current [A] 

LLC2 Output Voltage LLC2 output voltage [V] 

LLC2 LC Resonant Current LLC2 LC resonant current [A] 

LLC2 Secondary Current LLC2 secondary‑side current [A] 

LLC2 PWM Frequency LLC2 PWM operating frequency [Hz] 

 

 

Figure 5.6 Power Control Simulator Dialog 
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Operation Procedure (Basic Operations) 
1. Setting the simulation conditions 

Configure the simulation conditions as needed, such as AC Voltage Gain, load resistance values, and 
operating‑mode switching (SW operation). 

Each parameter can have multiple conditions defined, and the specified value will be dynamically 
applied during the simulation once the configured time [ms] has elapsed. 

2. Setting the simulation time 

Enter the simulation duration in “Simulation time [ms]”. 

3. Starting and stopping the simulation 

Click “Start Simulation” to begin the simulation. 

While the simulation is running, the button changes to “Stop Simulation”, which you can click to stop 
the simulation. 

After stopping, you can click “Start Simulation” again to resume the simulation. 

4. Checking Output Waveforms 

During the simulation, you can observe waveform trends of the power‑control operation, including 
time‑varying voltages and currents of the PFC and LLC stages, as well as PWM duty ratios. 

 

Operation Procedure (How to Switch to Normal Mode) 
To simulate the transition from Standby mode to Normal mode, set “Simulation time [ms]” to 600 ms or 
longer, configure SW2 in “Operating modes” so that it performs a short-press operation at 600 ms or later, 
and then start the simulation. 

After 600 ms has elapsed from the start of the simulation, the short-press operation of SW2 is applied, and 
the system switches from Standby mode to Normal mode. 

The above procedure is an example based on the default conditions. 

Depending on the circuit characteristics and power-control parameters modified in the Power Configuration 
view, adjust the timing values for “Simulation time [ms]” and “Operating modes” as appropriate. 

 

Estimated Simulation Time 
The computation performed on the PC depends on the simulation duration specified in “Simulation time 
[ms]”. 

Although the actual execution time varies depending on the performance of the PC, the following can be 
used as a general guideline. 

 

Table 5.9 Estimated Simulation Time 

Simulation time [ms] (Setting) Simulation Execution Time Execution Environment 

1000 Approx. 90 minutes CPU: Intel Core i7-13700 
Memory: 32 GB 
OS: Windows 11  
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Notes 
Setting a large value for “Simulation time” may increase execution time and memory usage, which could lead 
to errors. 

For details, refer to the release notes. 
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5.4.3 Evaluation of Power Control 
You can generate an evaluation program that reflects the parameters configured in the “Power 
Configuration” view. In addition, by using “Variable Read/Write” and “Variable Monitoring”, you can observe 
various parameter changes on the target board running the evaluation program in real time. 

 

 

Figure 5.7 Evaluation of Power Control 
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5.4.3.1 Build Settings 
Configure the build settings for the evaluation project so that it reflects the parameters defined in the Power 
Configuration view. 

 

(1) Selecting the compiler 

The generated project supports the following compilers: 

• CC-RL Compiler (e² studio) 

• CC‑RL Compiler (CS+) 

• IAR RL78 Compiler 

 

(2) Selecting the program type 

You can select the type of core that executes the power‑control processing: CPU or FAA. 

In this document, the following explanations assume that CPU is selected. 

 

5.4.3.2 Preparing the Evaluation Program 
Generate the evaluation program according to the selected compiler and program type. 

 

(1) Generating a project based on the settings 

Click “Generate project based on settings” to create the evaluation project. 

The project is generated in the following folder: 

<workspace>¥qeLighting_gen¥tuning program 

 

(2) Adding the communication program to the project 

Click “Add communication program to project” to add the communication modules used for Variable 
Read/Write and Variable Monitoring. 

*After adding the communication program, integrate the generated application program according to the 
instructions in the help documentation (select “Modify settings and create evaluation program (see Help)”). 

 

5.4.3.3 Downloading to the Board 
Write the generated project to the target board. 

Connect the E2 Lite to the E2 Lite connector on the debug board mounted on the target board, then click 
“Write evaluation program to evaluation board”. 
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5.4.3.4 Board Connection 
Use a USB cable to connect the target board to the host PC. 

This connection is used for communication during power‑control evaluation with Variable Read/Write and 
Variable Monitoring. 

Note: Before communicating, manually press SW2 to set the target board to Normal mode. Connect the USB 
cable to the debug board. 

1. Set “Bitrate” to 500000. 

2. Select the COM port connected to the PC in “COM Port”. 

3. Click the “Connect” button. 

 

5.4.3.5 Power Control Evaluation 
Evaluate the power‑control parameters on the target board in real time. 

Two evaluation functions are available. 

 

(1) Variable Read/Write 

Variable Read/Write allows you to read and monitor internal variables and register values of the application 
program in real time.  

All internal variables that can be monitored in this application note are read-only, and their values cannot be 
written or modified. 

Click “Open [Variable Read/Write] tab” to open the [Variable Read/Write] tab in the [Power Evaluation (QE)] 
view. 

 

 

Figure 5.8 Variable Read/Write 
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Operation Procedure 
1. Selecting variables for evaluation 

Select the power‑control variables to be evaluated from the variable list in the tab. 

2. Reading variable values 

Click the “Read” button to display the current values of the selected variables. 
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(2) Variable Monitoring 

Variable Monitoring continuously acquires internal variables and registers values of the evaluation program 
at a fixed interval and displays their time‑varying behavior as graphs. 

Click “Open [Variable Monitoring] tab” to open the [Variable Monitoring] tab in the [Power Evaluation (QE)] 
view. 

 

 

Figure 5.9 Variable Monitoring 
 

Operation Procedure 
1. Selecting variables to monitor 

Select the variables you want to display as waveforms from the channel drop‑down list in the tab. 

Multiple variables can be selected simultaneously. 

2. Setting acquisition conditions 

Configure the monitoring time and the display range of the output waveforms. 

3. Starting monitoring 

Click “Start Monitoring” to begin acquiring variable values and displaying the waveforms. 
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5.5 Code Generation and Programming 
You can generate a project that reflects the parameters configured during power‑control evaluation and write 
it to the target board. 

 

Figure 5.10 Code Generation and Programming 
 

5.5.1 Generating Source Code 
Click “Generate Source Code” to create the project. 

The project is generated in the following folder: 

“<workspace>¥qeLighting_gen¥solution” 

 

5.5.2 Downloading to the Board 
Click “Download to Board” to write the project to the target board via the E2 Lite. 
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5.6 Notes on PFC Control Parameters A1 and A2 
The coefficients A1 and A2 used in PFC PI control are internally calculated within the evaluation program 
based on parameters such as the zero‑point frequency (fZ) and proportional gain (Kp). Therefore, the A1 and 
A2 values computed or configured in the Power Configuration view or the simulator are not applied to the 
generated application program. 

To modify these parameters, you must directly change the values of the zero‑point frequency (fZ) and 
proportional gain (Kp) defined in the application program. 

 

5.6.1 Calculation Method for Kp and fZ 
You can calculate the zero‑point frequency (fZ) and proportional gain (Kp) from the A1 and A2 values 
computed or configured in the Power Configuration view or the simulator, using the formulas shown below. 

Note that the A1 and A2 values are multiplied by 65536 in the application program. Therefore, when 
performing the calculation, divide the A1 and A2 values by 65536 before substituting them into the formulas. 

In addition, the PFC feedback period T used in the target program is fixed at 400 μs. 

 

𝐾𝐾𝐾𝐾 =   
𝐴𝐴1 − 𝐴𝐴2

2
 

 

𝑓𝑓𝑓𝑓 =   
𝐴𝐴1 + 𝐴𝐴2

𝜋𝜋𝜋𝜋(𝐴𝐴1 − 𝐴𝐴2)
 

 

5.6.2 Applying Kp and fZ 
The zero‑point frequency (fZ) and proportional gain (Kp) obtained from the calculation formulas can be 
modified by directly editing the macro values in the application program. Specify each value as an integer. 

 

Table 5.10 Program Locations for Updating fZ and Kp 

Target File Macro Name Default Value Notes 

r_pfc.c PFC_DEFAULT_FZ 2 Unit: Hz 

PFC_DEFAULT_KP_EXT12 1024 Set the value multiplied by 4096, 
as required by the application 
program. 

Example: If Kp = 0.25 

0.25 * 4096 = 1024 
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6. Notes 
The sample program operations provided in this document are just examples. The application layer must be 
modified and evaluated according to the intended use. 

 

7. Reference Documents 
RL78/G24 User’s Manual: Hardware (R01UH0961) 

RL78 Family User’s Manual: Software (R01US0015) 

(Obtain the latest version of the manual from the website of Renesas Electronics.) 

 

Technical Update/Technical News 

(Obtain the latest information from the website of Renesas Electronics.)  
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General Precautions in the Handling of Microprocessing Unit and Microcontroller 
Unit Products 
The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 
2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins 

in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the 

level at which resetting is specified. 
3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 
4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 
5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 
6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 
7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 
8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms 

of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product. 
 
 



 

© 2026 Renesas Electronics Corporation. All rights reserved. 

Notice 
1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products 

and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of 
your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the 
use of these circuits, software, or information. 

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, 
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this 
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples. 

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics 
or others. 

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export, 
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required. 

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any 
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering. 

6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for 
each Renesas Electronics product depends on the product’s quality grade, as indicated below. 
 "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home 

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc. 
 "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key 

financial terminal systems; safety control equipment; etc. 
Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas 
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to 
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space 
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas 
Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas 
Electronics product that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document. 

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics 
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but 
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS 
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING 
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, 
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND 
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT 
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH 
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO 
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. 

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for 
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by 
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. 
Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products 
outside of such specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific 
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability 
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics 
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily 
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as 
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for 
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you 
are responsible for evaluating the safety of the final products or systems manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas 
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of 
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these 
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance 
with applicable laws and regulations. 

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is 
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations 
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions. 

12. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or 
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document. 

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics. 
14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas 

Electronics products. 

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled 
subsidiaries. 

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.  
(Rev.5.0-1  October 2020)  

0BCorporate Headquarters  1BContact information 
TOYOSU FORESIA, 3-2-24 Toyosu, 
Koto-ku, Tokyo 135-0061, Japan 
www.renesas.com 

 For further information on a product, technology, the most up-to-date 
version of a document, or your nearest sales office, please visit: 
www.renesas.com/contact/. 

2BTrademarks   
Renesas and the Renesas logo are trademarks of Renesas Electronics 
Corporation. All trademarks and registered trademarks are the property 
of their respective owners. 
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